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Abstract

Autophagy is a specialized catabolic process that selectively degrades cytoplasmic

components, including proteins and damaged organelles. Autophagy allows cells to

physiologically respond to stress stimuli and, thus, maintain cellular homeostasis.

Cancer cells might modulate their autophagy levels to adapt to adverse conditions

such as hypoxia, nutrient deficiency, or damage caused by chemotherapy. Ductal

pancreatic adenocarcinoma is one of the deadliest types of cancer. Pancreatic cancer

cells have high autophagy activity due to the transcriptional upregulation and post-

translational activation of autophagy proteins.

Here, the PANC-1 cell line was used as a model of pancreatic human cancer cells,

and the AR42J pancreatic acinar cell line was used as a physiological model of

highly differentiated mammalian cells. This study used the immunofluorescence of

microtubule-associated protein light chain 3 (LC3) as an indicator of the status of

autophagy activation. LC3 is an autophagy protein that, in basal conditions, shows

a diffuse pattern of distribution in the cytoplasm (known as LC3-I in this condition).

Autophagy induction triggers the conjugation of LC3 to phosphatidylethanolamine on

the surface of newly formed autophagosomes to form LC3-II, a membrane-bound

protein that aids in the formation and expansion of autophagosomes. To quantify the

number of labeled autophagic structures, the open-source software FIJI was utilized

with the aid of the "3D Objects Counter" tool.

The measure of the autophagic levels both in physiological conditions and in cancer

cells allows us to study the modulation of autophagy under diverse conditions such as

hypoxia, chemotherapy treatment, or the knockdown of certain proteins.
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Introduction

Macroautophagy (commonly referred to as autophagy) is

a specialized catabolic process that selectively degrades

cytoplasmic components, including proteins and damaged

organelles1,2 . Autophagy allows cells to physiologically

respond to stress stimuli and, thus, maintain cellular

homeostasis3 . During autophagy, a double membrane

vesicle is formed: the autophagosome. The autophagosome

contains the cargo molecules and drives them to the

lysosome for degradation1,4 .

Autophagosomes are decorated by the autophagic protein

microtubule-associated protein light chain 3 (LC3)5 . When

autophagy is not induced, LC3 is diffused in the cytoplasm

and nucleus in the LC3-I conformation. On the other

hand, when autophagy is induced, LC3 is conjugated

with a phosphatidylethanolamine in the membrane of the

autophagic structures6 . This new LC3 conformation is

known as LC3-II1 . The LC3 conformation shift causes

changes in its cellular localization and its dodecyl sodium

sulfate-polyacrylamide gel electrophoresis (SDS-PAGE)

migration, which can be detected by techniques such as

immunofluorescence and western blot5,7 . In this way, LC3

conjugation is a key event in the autophagic process that can

be used to measure autophagic activity.

The pancreatic acinar cell is a highly differentiated cell that,

under healthy conditions, has a low rate of autophagy.

However, in different physiological conditions or under

pharmacological stimulation, they can activate autophagy.

Therefore, the determination of autophagic levels in this cell

line is useful for studying the potential direct or indirect

effects of different pharmacological or biological agents on

autophagy8,9 .

Ductal pancreatic adenocarcinoma is one of the deadliest

types of cancer, given its late diagnosis and its

high chemotherapy resistance10 . Pancreatic cancer cells

have high autophagy activity due to the transcriptional

upregulation and post-translational activation of autophagy-

related proteins11 . Pancreatic cancer cells may adjust their

autophagy levels in response to unfavorable conditions

like hypoxia, nutrient deprivation, or chemotherapy-induced

damage11 . Hence, analyzing the autophagy levels in

pancreatic cancer cells can help understand how they adapt

to varying environments and evaluate the effectiveness of

autophagy-modulating treatments.

This study shows a method to perform LC3

immunofluorescence in two distinct pancreatic cellular

models. The first model, PANC-1 cells, served as a model for

pancreatic ductal adenocarcinoma. These cells were treated

with gemcitabine, a chemotherapy agent that has previously

been shown to induce autophagy, specifically in pancreatic

cancer cells carrying the oncogenic Kirsten rat sarcoma

virus gene (KRAS)12,13 . The second model, AR42J cells,

served as a more physiological model of exocrine pancreatic

cells. These cells were differentiated with dexamethasone to

become more similar to acinar pancreatic cells14 . In these

cells, autophagy was pharmacologically induced through

the use of PP242, which is a potent mTOR inhibitor15 . In

this study, we demonstrate the applicability of the protocol

described with two different pancreatic models and its ability

to discriminate between states of low and high autophagy.

https://www.jove.com
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Protocol

1. Cell preparation

1. Soak 12 mm round coverslips in absolute ethanol, and

place them vertically in the wells of a 24-well plate.

2. Remove the cover, and expose the multi-well plate to

ultraviolet radiation for 15 min.

3. Position the coverslips horizontally, and wash them with

Dulbecco's Modified Eagle Medium (DMEM).

4. Seed a low passage number of pancreatic cells.

The amount should be adjusted to obtain 50%-75%

confluency on the day of fixation16 .
 

NOTE: It is recommended to seed 2.5 × 104  PANC-1 or 4

× 104  AR42J cells per well to fixate the cells after 3 days.

5. Culture the cells in DMEM containing 10% fetal bovine

serum, 100 U/mL penicillin, and 100 µg/mL streptomycin

in an incubator at 37 °C under a humidified atmosphere

with 5% carbon dioxide (CO2).
 

NOTE: For PANC-1 cells, it is recommended to

incubate the cells for 2 days between cell seeding

and the following steps. After this time, the cells

can be transfected, treated, or fixated. This protocol

exemplifies the treatment with gemcitabine in non-

transfected PANC-1 cells and the differentiation and

PP242 treatment for non-transfected AR42J cells.

2. Treating the cells

1. Gemcitabine treatment for PANC-1 cells

1. Prepare a solution of 1 µg/µL gemcitabine in DMEM

2 days after seeding. Treat each well with 2.6 µL of

the 1 µg/µL gemcitabine solution to achieve a final

dilution of 20 µM.

2. Incubate the cells for 24 h in the incubator.

2. AR42J differentiation and PP242 treatment

1. Prepare a solution of 4 µg/mL dexamethasone in

DMEM.

2. Treat each well with 4.9 µL of 4 µg/mL

dexamethasone solution to obtain a final dilution of

100 nM.

3. Incubate the cells for 48 h in the incubator.

4. Remove the medium, and treat each well with 0.5 µL

of 1 mM PP242 to obtain a final dilution of 1 µM.

5. Incubate the cells for 2 h in the incubator.

3. Fixing and permeabilizing the cells

1. Prepare a 24-well plate with cold methanol and a 6-well

plate with cold phosphate-buffered saline (PBS; 137 mM

NaCl, 2.7 mM KCl, 8 mM Na2HPO4, 2 mM KH2PO4).

Maintain them on ice.

2. Take each coverslip with tweezers, wash it twice in PBS,

and incubate for 6 min in methanol.

4. Blocking the cells

1. Wash each coverslip twice in PBS, and incubate for 1 h

in 10% fetal bovine serum in PBS (blocking solution).
 

NOTE: In this step, the protocol might be paused. The

coverslips can be stored overnight in the fridge in the

blocking solution, and the protocol can be continued the

following day.

https://www.jove.com
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5. Incubating the coverslips with the primary
antibody

1. Prepare a 1:1,000 solution of anti-LC3 in the blocking

solution, and maintain it on ice.

2. Place a piece of laboratory sealing film over the multi-

well lid.

3. Place one drop (25 µL) per coverslip of anti-LC3 solution

over the sealing film.

4. Take each coverslip with tweezers, and place it over the

primary antibody drop, taking care that the cell side is in

contact with the solution.

5. Prepare a humid chamber by placing a humid piece of

paper into a flat-bottom plastic box.

6. Place the multi-well plate into the humidity chamber,

cover it with foil, and incubate overnight in the fridge.

6. Incubating the coverslips with the secondary
antibody

1. Remove the multi-well plate from the humidity chamber,

and place the coverslips back in the multi-well plate.

2. Perform three washes with PBS.

3. Prepare a solution of fluorescently labeled anti-rabbit with

a dilution of 1:800 in the blocking solution, and maintain

it on ice protected from light.

4. Place a sealing film piece over the multi-well lid.

5. Place a drop (25 µL) per coverslip of anti-rabbit solution

over the sealing film.

6. Take each coverslip with tweezers, and place it over the

primary antibody drop, taking care that the cell side is in

contact with the solution.

7. Incubate the multi-well plate in the humidity chamber for

2 h at room temperature (RT) protected from light.

7. Staining the cells with 4′ ,6-diamidino-2-
phenylindole (DAPI)

1. Remove the multi-well plate from the humidity chamber,

and place the coverslips back in the multi-well plate.

2. Perform three washes with PBS.

3. Prepare a 300 nM solution of DAPI in PBS (protected

from light).

4. Incubate each coverslip with the DAPI solution for 10 min.

5. Perform three washes with PBS. Maintain the multi-well

plate protected from light.

8. Montage

1. Prepare two beakers with water and a piece of paper.

2. Place one drop (10 µL) per coverslip

of a polyvinyl alcohol-Bis(trimethylaluminum)-1,4-

diazabicyclo[2.2.2]octane adduct (PVA-DABCO)

solution on a slide.
 

NOTE: PVA-DABCO is prepared by combining 0.25 M

DABCO, 10% W/V PVA, 20% glycerol, and 50% Tris HCl

(1.5 M, pH 8.8) in ultrapure water.

3. Take each coverslip with tweezers, wash it in each water

beaker, dry it off in the paper, and place it over the PVA-

DABCO drop (with the cells in contact with the solution).

4. Let it dry overnight, protected from light.

9. Confocal microscopy viewing and image
capture

1. Visualize the coverslips in an inverted confocal

microscope using an objective of around 63x17 .

https://www.jove.com
https://www.jove.com/
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2. Capture representative images of the labeled cells.

10. Quantifying the LC3 dots

1. Drag and drop each image file containing the captured

channels, such as ".czi", into the ImageJ (FIJI) screen

to open. Click on Ok in the dialog box, and close the

Console window.

2. From the Image tab, select Color > Split Channels.

3. Close the images corresponding to the channels other

than the LC3 image.

4. From the Image tab, select Adjust > Color Balance

5. Move the Maximum slider to the left until the image is

saturated to visualize the cell contours.

6. Draw the cell outline with the Freehand Selection tool.

7. Click on the Reset button to reset the color adjustment.

8. From the Edit tab, select Cut to cut the selected item.

9. Close the image without saving it.

10. From the Edit tab, select Paste.

11. In the Analyze menu, choose the tool 3D Objects

Counter.

12. Set the threshold. In the example provided in this study,

the threshold is set at 2,000.

13. Set the size filter. In this study, it is set between 50 and

500.

14. Be sure that the boxes Objects and Summary are

marked.

15. Click on Ok. The number of dots will be described as

Objects Detected in the Summary.

 

Figure 1: Schematic diagram of the LC3 immunofluorescence protocol. Schematic diagram that represents the general

protocol provided for LC3 immunofluorescence. Figure created with BioRender.com. Please click here to view a larger

version of this figure.

https://www.jove.com
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Representative Results

This protocol performs immunofluorescence of LC3 in

pancreatic cell lines to determine the autophagy levels in

different conditions. The outcome of this experiment was

the obtention of cellular images from the red and blue

channels, corresponding to LC3 and DAPI. The LC3 images

indicate the cellular distribution of this protein, whereas the

DAPI shows the nuclear localization. Figure 2A shows a

representative image of the immunofluorescence of LC3 and

its merge with DAPI staining in PANC-1 cells under basal

or gemcitabine treatment conditions. A set of images of LC3

staining was analyzed using the tool 3D Objects Counter in

FIJI. Using this software, the amount of LC3 dots per cell was

quantified. The bar graph in Figure 2B shows the results of

LC3 dot quantification in PANC-1 cells under basal versus

gemcitabine treatment conditions. In this graph, the LC3 dots

significantly increased under gemcitabine treatment, with the

number of LC3 dots directly indicating the autophagic activity.

We also previously demonstrated that gemcitabine triggers

autophagy in pancreatic cancer cells12 . Overall, the method

presented in this article allows the detection of the level of

increase in autophagy activation induced by gemcitabine in

these cells.

While this protocol focuses on using LC3

immunofluorescence to determine autophagic activity in

pancreatic cancer cells, it could potentially be applied to other

cell lines, including more physiologically relevant models.

To test the method's efficacy in assessing physiological

responses, the AR42J cell line was used. Although

these cells are derived from a rat exocrine pancreas

tumor, they can be differentiated into exocrine cells with

glucocorticoid stimulation, thus making them a suitable

pancreatic model8,14 ,18 . The AR42J cells were differentiated

with 100 nM dexamethasone treatment for 48 h, followed

by treatment with the mTOR inhibitor PP242 to induce

autophagy15 . The obtained results are presented in Figure

3, which shows a significant increase in the number of LC3

dots per cell under the PP242 treatment.

Thus far, we have demonstrated that the presented method is

effective for assessing autophagic activity in both cancer cells

and a more physiological model. However, it is important to

note that minor deviations from the presented protocol could

result in uninterpretable results.

Figure 4A shows a representative image from a suboptimal

experiment in which too many cells were seeded on the

coverslips, and excessive confluence was obtained. This kind

of experiment might be uninterpretable for diverse reasons.

Firstly, the cellular types mentioned in this work are derived

from the exocrine pancreas, where the cells are grouped in

acini. Under an excessive confluence, these cells tend to

pile up and grow on top of each other (such as cell 1 and

cell 2 in Figure 4A, which are above cell 3 and cell 4). This

phenomenon makes it practically impossible to know which

cell the LC3 dots belong to, thus making it very difficult to

estimate the number of dots per cell. On the other hand,

cells at high confluency tend to be stressed, which triggers

autophagy. As a result, the differences in autophagic levels

between the control and treated cells might decrease due to

an increase in the background autophagic activity.

In Figure 4B, a representative image from another kind of

suboptimal experiment is shown in which the cells were

fixed with paraformaldehyde instead of methanol. While this

fixation method is generally effective for preserving a variety

of proteins, it is not suitable for LC3, as the resulting image

does not accurately reflect its true distribution. This technical

https://www.jove.com
https://www.jove.com/
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mistake might make it impossible to find differences between

low and high autophagic levels.

Generally, cell lines can be treated, transfected, or fixed 1 day

after seeding. Nevertheless, it is crucial to mention that, in

the case of PANC-1 cells, it is necessary to wait for 2 days

after seeding to ensure the complete adherence of the cells to

the glass coverslips before proceeding with the subsequent

steps of the experiment. Figure 4C shows a representative

image from an experiment in which the cells were treated

with gemcitabine just 1 day after seeding. From the figure, it

can be observed that the cells in this experiment had a round

shape. This morphology decreased the relation between the

cytoplasm and nucleus, making it difficult to understand the

intracellular distribution of LC3 and to discriminate between

low and high autophagic levels. It is important to note that

AR42J does not have this problem, and they are ready to be

treated or fixed on the day following the seeding.

Another suboptimal outcome could be obtained when the

time of methanol fixation is varied. Shorter times of fixation

might cause incomplete fixation, as represented in Figure 4D,

where the cells were fixed for 3 min. Incomplete fixation can

interfere with proper LC3 immunolabeling, leading to unclear

images and suboptimal quantification.

 

Figure 2: LC3 immunofluorescence in PANC-1 cells under basal or gemcitabine conditions and LC3 dot

quantification. The PANC-1 cells were either treated with 20 µM gemcitabine for 24 h or left untreated and then

immunolabelled with anti-LC3. (A) Representative images of each condition are shown. Scale bar: 10 µm. (B) The bar graph

represents the means and standard errors of the means (SEM) of the LC3 dots per cell for each condition. N = 10 cells per

condition from three independent experiments. *** p < 0.001 by a Student's t-test. Please click here to view a larger version

of this figure.

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/65005/65005fig02large.jpg
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Figure 3: LC3 immunofluorescence in AR42J cells under basal or PP242 conditions and LC3 dot quantification. The

AR42J cells were differentiated with 100 nM dexamethasone for 48 h and then either treated with 1 µM PP242 for 2 h or left

untreated, followed by immunolabelling with anti-LC3. (A) Representative images of each condition are shown. Scale bar:

10 µm. (B) The bar graph represents the means and standard errors of the means (SEM) of the LC3 dots per cell for each

condition. N = 10 cells per condition from three independent experiments. ** p < 0.01 by a Student's t-test. Please click here

to view a larger version of this figure.
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Figure 4: Suboptimal experiments. Representative images of LC3 immunofluorescence in suboptimal experiments

are shown. Scale bar: 10 µm. (A) Excess confluence: 7 × 104  PANC-1 cells were seeded, treated with gemcitabine, and

immunolabelled with anti-LC3. Four cells are marked to show that cell 1 and cell 2 are above cell 3 and cell 4. (B) PFA

fixation: PANC-1 cells were treated with gemcitabine, fixated with PFA, and immunolabelled with anti-LC3. (C) Incomplete

stretch: PANC-1 cells were treated with gemcitabine the day after seeding and immunolabelled with anti-LC3. (D) Incomplete

fixation: PANC-1 cells were treated with gemcitabine, fixated with methanol for 3 min, and immunolabelled with anti-LC3.

Please click here to view a larger version of this figure.

Discussion

The method described in this protocol allows for visualizing

the endogenous LC3 distribution in the cell and quantifying

the autophagic levels under different conditions. Another

similar method used to analyze the LC3 distribution

and determine autophagy activation involves fluorescence-

labeled LC3 transfection (such as RFP-LC3)19 . RFP-LC3

transfection has the advantages of not needing fixation (which

allows for applying this method in live cell imaging20 ), being

cheaper, and not depending on LC3 antibody reactivity. On

the other hand, the immunofluorescence of LC3 has the

advantage of providing an image of the endogenous LC3,

thus avoiding possible issues related to LC3 overexpression,

such as the formation of protein aggregates that are

independent of autophagy21 . Moreover, this method does not

depend on the ease of transfecting the cells, meaning it is

applicable to diverse cell lines. However, depending on the

LC3 antibody that is used and its reactivity, there are some

cellular lines in which it might not work. Some antibodies may

work well for certain species but not for others, even when

they are theoretically compatible with different species. In the

case of the antibody used in this protocol (LC3B D11), we

have found that it works perfectly for human cells (PANC-1,

HEK293T, HeLa) and rat cells (AR42J). However, it does not

work for mouse cells (MEF cells), as we observed nonspecific

nuclear staining. It is worth noting that the quantification

of LC3 spots, whether endogenous or overexpressed, has

limitations in distinguishing between changes in autophagy

https://www.jove.com
https://www.jove.com/
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activation, which may indicate the increased production

of LC3-II, and changes in LC3-II degradation, which may

indicate an autophagic flux state. Additional methods can

be used to comprehensively assess autophagy activity. For

instance, the use of RFP-GFP-LC3 expression can provide an

accurate assessment by distinguishing between LC3-II inside

or outside of the lysosome22,23 .

As shown in Figure 4, there are some critical steps in

the protocol that must not be modified, given that their

modification can lead to suboptimal outcomes. First, it is

important to set the correct number of cells to be seeded.

When not enough cells are seeded, they tend not to resist

transfection or treatments and remain rounded. On the

contrary, when cells are seeded in excess, they tend to

grow on top of the neighboring cells, making it challenging

to focus on individual cells and distinguish between their

LC3 dots. Notably, in situations where cells are in close

proximity but not overlapping as depicted in Figure 4A, it may

be helpful to use immunostaining with specific membrane

markers, such as EGFR, to distinguish between the positive

markers belonging to each cell24 . However, it is important

to note that certain markers like E-cadherin and EpCAM are

not suitable for this purpose in PANC-1 cells due to their

reduced membrane expression, which results from the typical

epithelial-mesenchymal transition process associated with

this cell type25,26 ,27 . Secondly, when working specifically

with PANC-1 cells, it is essential to wait at least 1 day between

the seeding and the subsequent steps of the experiment.

Conversely, when one does not wait for the right time, the

cells can be rounded, making it difficult to interpret the results.

Thirdly, fixation is a critical step in this protocol. As we have

shown, the method only works with an adequate methanol

fixation. Paraformaldehyde fixation does not work correctly

for LC3 immunolabelling, while the methanol fixation time

should not be modified, given that shorter times might lead

to an incomplete fixation. We tested methanol fixation times

up to 1 h and did not observe differences in LC3 labeling.

Nevertheless, we advise against the use of prolonged fixation

times, as methanol fixation can lead to the loss of soluble

cellular proteins and free fluorescent molecules28 . Therefore,

it is recommended to adhere to the standard fixation time to

ensure precise and dependable results.

Some modifications might be accepted in the described

protocol. For example, a 12-well plate can be used instead

of the 24-well plate, as well as growing the cells over 15 mm

round coverslips instead of 12 mm coverslips. In this case, it

should be considered that the number of cells to be seeded,

as well as the volumes of reagents used, will be greater

than those described in this protocol. In this case, 4 × 104

PANC-1 and 6.5 × 104  AR42J should be seeded. Additionally,

the used blocking solution can be replaced with others, like

1% BSA in PBS, and this would lead to similar results. In

the same way, the blocking time could be increased up to

24 h without significantly altering the results. The antibody

incubation times and concentration might be adjusted and

can change, for example, if another LC3 antibody is used.

Although PVA-DABCO solution is prepared in this study,

commercial montage solutions can also be used. On the

other hand, the quantification method can be modified. For

example, applying some filters or masks to the images

is possible, and an alternative tool can be used for dot

quantification.

In this work, we directed the application of the

immunofluorescence of LC3 to study the behavior of

pancreatic cancer cells. In these cells, autophagy is

basally activated and might be modulated as a response

to diverse stressful situations, such as chemotherapy,

https://www.jove.com
https://www.jove.com/
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hypoxia, or nutrient deficiency11,12 . The determination of

autophagy in these cells may be applicable to studying the

cellular response to chemotherapy, radiotherapy, or other

treatments that modulate autophagy. As shown in Figure

3, the presented method can be applied in physiological

models. Although, in this work, we focused on the

quantification of autophagic levels, the immunofluorescence

of LC3 might also allow the evaluation of the colocalization

between LC3 and diverse proteins. It can serve, for example,

as a mechanistic approach to mark proteins at different

points in the autophagic process and evaluate whether the

colocalization with LC3 is affected by some treatments or by

the downregulation of some proteins. In this way, it could be

determined, for example, whether some autophagy inhibitor

interrupts the autophagic flux before or after LC3 conjugation.

Finally, the method can also be adapted to tissue samples to

determine autophagy activation in animal models or human

biopsy samples.
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